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2D digital art is
currently growing

at an amazing rate.
Obviously, this has
a lot to do with the
growth of the digital
market itself, but

as the technology
becomes less
expensive, allowing
the “home hobbiest”
users to be able to
afford tablets, faster
and better computers,

and more intuitive

software, we see a
huge number of artists taking up the digital lifestyle. We even see some
hardened 3D’ers trying their hand. And why not, after all, some of the
work we see daily is stunning. Will we look back in 100 years at the artists
featured in this magazine and see them as the ‘pioneers’, or the original
‘masters’?... Only time will tell. The three artist interviews this month have
all got an opinion when it comes to the digital revolution. Some see it as
purely another tool, some as a time saving device. There are those who
see it as the gateway for a lot of artists to fulfil dreams, such as comic
book artist wannabes who can now produce full-colour comic strips with
the most basic of digital tools and software at home! Whatever your
opinion is, | think we all have to agree that the current state of the 2D CG
industry is looking good. Directors have a current preference for digital
matte paintings over 3D CG backgrounds; a trend which was so different
only a few years ago, and if you need any more convincing, just look at

the fantastic work in this months issue... Enjoy! Ed.
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Every month, many creatives and artists around the world contribute to
3DCreative & 2DArtist Magazines. Here you can read all about them. If

you would like to be a part of 3DCreative or 2DArtist Magazines, please

contact: ben@zoopublishing.com

Freelance lllustrator

& Maya Artist, USA.

Currently waiting
to begin my senior

year at Ringling

College. I'm majoring

in Computer Animation but will be pursuing
freelance illustration work upon my 2008
graduation. | have graciously been featured
in Spectrum and Creative Quarterly and am
looking to build up my clientele and portfolio.
fvallejo@ringling.edu

http://francisvallejo.blogspot.com

Designs identities,
brochures, flyers and
so on, and sometimes
illustrations at a small

company in Budapest,

Hungary. Apart from

graphic design, he works to improve his digital
painting, which is a pleasure for him. He usually
works with Painter and ArtRage, but nowadays
his main goal is to develop his portfolio, trying
out several styles and techniques.
janos.kiss@28thwing.com

www.28thwing.com

Is a Matte Painter,
Texture and a

Concept Artist, in
England. In 2003,

straight out of

university, he started

work at MPC, London, as a Matte Painter.

He’s since worked on many amazing projects
including Xmen 3, and a TV adaptation of Terry
Pratchetts ‘Hogfather’, doing texturing, matte
painting & concepts. He loves to paint and to
create.

sketchling@yahoo.com | www.sketchling.com

Babanssihy

Is a Production/
Concept Artist, at
PitchiPoy Studio, in
Israel. He has drawn

and painted since

he can remember;

creating characters, creatures and fantastic
scenes have always been a passion. Telling a
story through a single image can be a challenge,
but he’s always up for it! Keeping his work fresh
and versatile, he explores all genres and styles.
Pat2005b@hotmail.com
http://chuckmate.blogspot.com

Has had a passion
for drawing since
being a couple of feet

tall. He studied Fine

Art and was eventually

led into the realm of

computers several years ago. His brushes have
slowly dissolved in white spirit since the late ‘90s
and now, alas, his graphics tablet has become
their successor. He sketches regularly and
shares time between both 2D & 3D, although
drawing will always be closest to his heart...

ibex80@hotmail.com
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A.K.A Deevad, is

a Freelance 2D
lllustrator & Concept
Artist, in Toulouse,

France. He started

working in the field of

CG in 2001 after a career in traditional painting
and illustration. Now working as a Concept
Artist for anime studios, and as an lllustrator for
book covers, he wishes to evolve his career to
video games, especially as Concept Artist & Art
Director for an RPG. info@davidrevoy.com

www.davidrevoy.com

Is a freelance all-

rounder, in Bulgaria.
He's worked on game
development projects,

covering every aspect

of art asset creation,

from concept art, modelling, texturing, rigging, &
animation, to renaming images back in the 2D
games era. He currently works as a freelance
artist as he needs money for food, clothes, an
HDV camera, and another motorcycle.
kosta@kostaatanasov.com

www.kostaatanasov.com

s

Isa 2D & 3D Game
Artist, for Midway
Games, in Chicago.
He became interested

in art & drawing in his

senior year at high

school. His education took him through 2 years
at the American Academy of Art, and 2 years at
the lllinois Instiute of Art, where he majored in
Game Art & Design. He is currently employed
by Midway Games, fulfilling the roll of a 3D
Character Artist. ivanMijatov@gmail.com

http://ivanushka.deviantart.com

Daarken

Is a 2D lllustrator/
Concept Artist, in
the USA. He began
working in the

gaming industry

after graduating from

the Academy of Art

University, San Francisco, in 2004. He has
worked for Wizards of the Coast, Fantasy Flight
Games, Widescreen Games, Digital Extremes,
& BreakAway Games.

www.daarken.com

daarkenart@daarken.com

mhalfle

Grew up in Sarajewo,
Bosnia, attending

the School of Fine
Arts. The war came

& he left. Moving

to Switzerland, he

started doing graphic design & animation,
and now works as a freelance Concept Artist,
lllustrator & Matte Painter. He directs shorts
and music videos, works in post production
as Animator & Compositor, and composes
soundtracks for ads, games & movies.

info@streamatica.ch | www.streamatica.ch

3Dealive on 2ZUList lagazine?
We are always looking for tutorial artists, gallery submissions, potential
interviewees, Making Of writers, and more. For more information, send a

link to your work here: warin@zoopublishing.com
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Interview Z;/an J’

Hello Evan, could you tell us what first got you

hooked on 2D?

| think the first time visual effects peaked my
interest was when | was a very young child
watching films like Star Wars - even with no
idea as to how it was done | still wanted to be
part of it and it was only after a short stint in
the print design industry that | was exposed to
what could be achieved with Photoshop. | had
always been interested in early digital paint
programs from Dazzle Draw to Deluxe Paint 2
on my old Apple IIGS. | would draw my favourite
characters pixel by pixel in 16 colours and print
them out on a dot matrix printer. After watching
a matte painting/visual effects seminar in 1999
at Enmore Design Centre in Sydney, | was

hooked.

So after watching this seminar, could you tell

us about the course of education that you have
travelled?

| spent 2 years studying graphic design which
included print, web, illustration and photography.
This led me to a job in the print design industry.
After a couple of years working on magazines |
attended the seminar which inspired me to apply
for a scholarship studying 3D, visual-FX, and
animation. | won the scholarship and after 12

months | was in the industry.

Could you tell us how your style of painted
emerged?

I think my digital art has always tried to mimic a
painterly approach. | was never fond of the sharp,
crisp, sterile 3D/2D art that was so popular in

the past and have always wanted to push my art
in a different direction. | came from a traditional
illustration background and focused on illustration
techniques in college. With my art | always try

to create a mood and play with light to capture a

cinematic frame.

Photographers use a lot of light to set moods

for their images; is this something that you have
dabbled with to help you understand light better?
| have always had a interest in photography

and from a young age was encouraged by my
parents. My composition was one thing that my
father would always comment on. In college |
studied photography and darkroom techniques.
Light is something I'm very interested in.
Observation is the key in learning how it all works

and you will always notice something new.

A lot of your work seems to have a similar theme
running through it: war. Is this something that you
have a fascination of?

The work on my site does seem to have a theme.
| guess the whole idea of battle, or the human
condition during war, really strikes a chord with
me. It is often dramatic and visually interesting.
My interests stem from history and the fact that
my grandfather served in WW2. He was an RAF
Night Fighter Ace who served in Malta flying with
the RAF. | am also a fan of the design during
WW?2 - the various hardware that was built out

of necessity, and the idea that a lot of it in turn

influenced the technology that we use today.
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Does this also have a bearing upon the types of
projects that you undertake in your professional
career? As | have noticed that the majority do
have a war/military theme to them...

| would love the opportunity to conceptualize
and work on a classic WW?2 film. Choice doesn’t
really come into a lot of the projects that | have
worked on; it is pretty much down to the luck of
the draw or it depends on what the company |
am working for are bidding on. It would be great

to pick and choose projects but often this just

isn’t the case. Obviously being passionate about
something is going to bring out your best, but it
is still a job and you get the good along with the

bad.

You’re currently working freelance; what do you
feel are the advantages and disadvantages of
this kind of work?

| have recently moved to a freelance position
which has given me the opportunity to pursue

personal projects and also to travel and vary the

work that | do. Experiencing different companies

and different techniques/work-flows allows you
to grow as an artist. The down-side to travelling
for freelance work is that you have to leave your

family at home.

When you first start a painting, whether it’s for
your work or for your own personal portfolio,
what are the first things that you do before
picking up your Wacom tablet?

The initial stages of the painting are always
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the most fun. Firstly, before picking up a pen, |
usually make sure that | have done my research
and | then explore composition. Generally this
is done digitally but | often use pencil and paper
too. With most of my commercial concept art

| am trying to represent a story beat, or to sell

a cinematic mood, so it is very important that
thorough research is done, whether it is reading
the script/book or Google-searching for images.
Often a chat with the other artists working on the
project is also essential as they can bring things

to the plate that you didn’t think of.

Have you ever been disappointed with an
outcome of a project, whether it has been
personal or professional?

| do finish projects that | feel could have been
better - most of the time it is due to time or
budgetary restraints, but it makes the projects

that you are proud of feel that much better.




What has been the most memorable piece of advice that you have been given?

Off the top of my head | don’t remember one particular, memorable piece of advice. | am always
asked for advice about getting into the industry or what courses or software to learn... Exploring
design and art in all its different forms is more essential than learning one particular software
package. But most of all, discipline and practice is at the top of the list. | believe in working on good,
interesting projects with talented people and growing as an artist. If this isn’t the case then there isn’t

much point in pursuing it - it's that simple.




Well it has been a real pleasure talking with you. One last
question before we finish: if | was to hang around with you for a
whole day, what would | learn about you that not a lot of people

know?

Zvan Shipand

For more work by this artist please visit:
Or contact them at:

Interviewed by
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DIGITAL ART MASTIER

AVAILABLE FROM WWW.3DTOTAL.COM/SHOP

THE FIRST BOOK IN THE “DIGITAL ART MASTERS” SERIES CONTAINS WORK BY THE FOLLOWING ARTISTS:

ANDRE HOLZMEISTER, ANDREY YAMKOVOY, BALAZS KISS, CETIN TUKER, DANIELE MONTELLA, D'ETTORRE OLIVIER-THOMAS, DONALD PHAN, DRAZEN-
KA KIMPEL, EGIL PAULSEN, ERIC WILKERSON, FABRICIO MICHELI, FRANCISCO FERRIZ, FRED BASTIDE, FREDRIK ALFREDSSON, HAURE SEBASTIEN, JESSE
SANDIFER, JORGE ADORNI, JUAN J. GONZALEZ, JULIANO CASTRO, KHALID ABDULLA AL-MUHARRAQI, LANDIS FIELDS, LAURENT GAUMER, LAURENT
MENABE, LI SULI, LINDA TSO, MARCEL BAUMANN, MARCO SIEGEL, MARISKA VOS, MENY, HILSENRAD, NATASCHA ROEOESLI, NICOLAS RICHELET, NIELS
SINKE, NORBERT FUCHS, OLLI SORJONEN, OMAR SARMIENTO, PATRICK BEAULIEU, PHILIP STRAUB, PISONG, RICHARD TILBURY, ROB ADAMS, ROBERT
CHANG, ROMAIN COTE, RONNIE OLSTHOORN, RUDOLF HERCZOG, RYAN LIM, SIKU AND THIERRY CANON

THE DIGITAL ART MASTERS 287


http://www.3dtotal.com/book

SynthEyes 2007 ®

3-D Camera Tracking Software

Now with

I AG RSB ZATON

Maybe you are shooting hand-held, and need a more professional look. Maybe you are using other stabili-
zation software, but are tired of limited functionality, poor tracking, or strange geometric distortions in the
results. We've got the cure!

SynthEyes now includes an awesome image stabilizing system, based on SynthEyes’s famously fast and
accurate tracking. Integrating auto-tracking and stabilization makes for a terrifically fast workflow, and
means we can do all the sophisticated things to produce the highest-quality images possible. We added
the flexibility to nail shots in place, but also to stabilize traveling shots. Then, piled on a full set of controls
so you can direct the stabilization: to change shot framing, add life, or minimize the impact of big bumps
in the footage. Since you've got other things to do, we multi-threaded it for outstanding performance on
modern multi-core processors.

We didn’t forget about pure camera tracking either. SynthEyes 2007%2 adds single-frame alignment for
nodal tripod and lock-off shots; a way to add many accurate trackers after an initial solve, for mesh build-
ing; a way to coalesce co-located trackers, perfect for green-screen tracking; and about 50 other things.

One thing we didn’t change—our incredible price:

"l used SynthEyes exclusively while working on Pan's
Labyrinth, and the CG Supervisor was continually amazed
at how | was blowing their deadlines clean out of the water.

| used the zero-weight points to model many surfaces
which needed to be very accurate, so that a 3-D stick bug
could walk across them.”— Scott Krehbiel

“2D at FUEL used SynthEyes for a few especially gnarly
shots during Charlotte's Web. For $399 and a couple of
hours invested in the docs, our compositors can solve a

camera for almost any shot. SynthEyes is smoking fast,
easy to understand and the support is phenomenal.”
— Sam Cole, FUEL

Other recent credits: Apocalypto, Bridge to
Terabithia, Casino Royale, Deja Vu, Next,
Pirates of the Caribbean: Dead Man's Chest,
Pursuit of Happyness, Spiderman 3, Zodiac

See the website for more details on ANDERSSON TECHNOLOGIES LLC

SynthEyes'’s amazing feature list. For more information and free demo:
http://www.ssontech.com

Fourth year in the market,
PC/PC 64-Bit/Intel Mac/PowerPC Mac serving VFX artists in over 40 countries

25+ Exporters included standard.


http://www.ssontech.com




an neniewvitn Lanl Onilchlowr

Let's start with “Thrud”
- a character that must
remain close to your
heart. Could you tell
us a little about his
evolution and what

inspired his creation?

The graphic design

tutor at my foundation
art college was Bryan Talbot (Luther Arkwright, “The Tale of One Bad
Rat”, and so on) and one of his projects was to produce a comic strip... |
was reading Robert E. Howard's “Conan” books at the time and this lead

to my first “Thrud” strip - the first comic strip that | ever drew!

Thrud and Conan are both “Barbarians”, but what is it about this type of
character that interests you in terms of a comic strip?

To be honest, the appeal is in the imagery involved - | just like drawing
heavily muscled men running around in their under crackers - you got a

problem with that? (Note: | HATE drawing suits.)

Could you describe your work on the “Magic: the Gathering” cards and
explain to any unaware readers what they are exactly?

To any readers who don’t know, “Magic: the Gathering” is a Collectable
Card Game (CCG), produced by Wizards of the Coast, with a strong
fantasy element. Over the last few years I've produced close to 200
images for different playing cards for the game, as new sets are released
each year. They have mostly been monsters of various descriptions; many

of which can be seen on my website: www.carlcritchlow.com.

Would you say that fantasy is a genre that suits your personality, being
someone who enjoyed the Conan novels, or are there any another topics
you would like to explore in more depth?

I'm a big fan of the R. E. Howard Conan stories, but although | enjoy some

of the visual elements of the fantasy genre, to be honest | haven't really

read too much else - even though it's fun to draw!
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M &MM Interview

What was it that initially led you into the world of

comics and prompted an interest in this genre?
Until | went to art college | hadn't really had an
interest in comics, although | was a huge Frank
Frazetta fan and | knew that was how he’'d
started his career, so | was interested in finding
out more. As | mentioned before Bryan Talbot
was my graphics tutor, as well as teaching he
was working on the first of his Luther Arkwright
stories and it was seeing his work (as well as
his comic collection) that led me to realise there
was a ton of fantastic stuff out there that I'd

previously been unaware of.

What is it essentially about Frazetta's work that
inspires you?
| could go on about this for some time but in one

word it's the dynamism.
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Thrud®© Carl Critchlow : All Rights Reserved.



How do you think that comics have changed with the advent of computers and
the digital medium?

Apart from making the whole job quicker, cleaner and more accurate (especially
colouring and lettering) the main change as | see it is that it is now perfectly
possible for an individual creator to produce an entire comic book to a

professional standard at home.

What do you think are the skill sets necessary to being a good comic

artist, and what do you feel are the greatest challenges?

General draftsmanship (especially figure drawing) is essential, as well

as storytelling (very important if you want to make any sort of a living),

and speed. The challenges are being able to keep banging the stuff out,
whether you're in a really creative mood and buzzing, or full of cold/hung-over
with something that seems much more interesting on the TV: a deadline’s a

deadline (or so I've been told).

How did it feel to contribute towards the Dredd history and were there any
specific challenges that the job presented?
I'd been a fan of 2000AD for many years before getting a chance to contribute,

and it was a real honour to finally get to work on the top character. As far as

an neniewvitn Lanl Onilchlowr
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specific challenges go, the shoulder pad and
eagle can be a headache in certain poses,
although my most nerve-wracking moment
was having to sketch Dredd

whilst appearing on a panel at a
Norwegian convention. Every

pencil mark was being projected

onto a big screen as | worked,

and | really don’t think that most

of the audience knew either

me, or the character. And if all

that wasn't bad enough, | was

sitting next to Carlos Ezquerra!l

Judge Dredd © Rebellion : All Rights Reserved.



Which comic artists would you rank as your
favourites of all time, and why?

There are lots and for all sorts of different reasons,
but for consistently creative high standards it
would be a toss up between Mike McMahon and
Mike Mignola. Other favourites of mine include
(off the top of my head and in no particular order)
Duncan Fegredo, Jamie Hewlett, Simon Davis,

Nicolas de Crecy and Masamune Shirow.

How would you describe your comic book style?

Iffy.

What do you think are the most important pieces
of advice you could offer to anyone interested in
becoming a comic book artist?

Forget being a comic book artist get a proper job

and a social life. You'll thank me in the long run!

an neniewvitn Lanl Onilchlowr

If you had not been an artist what career do you think you would have
followed?
A question | seem to be asking myself more and more recently... I'm really

not sure, but something that finishes at 5 PM every Friday has it's appeal.

Thanks for talking to us Carl.

No problem. Thanks for asking me and | hope it all made some sort of sense!

Lark Dvilchlour

For more work by this artist please visit:
http://www.carlcritchlow.com

Or contact them at:

c.crit@virgin.net

Interviewed by: Rich Tilbury
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Hi Dan, how are you? It's great to have this
opportunity to chat with you, so can we start

off simply by learning a little bit about you?

For example, what’s your current location and
occupation, and are you working on any exciting
projects right now?

Hi Lynette! Good to chat with you too. I'm
currently located in a suburb just outside Kansas
City, Missouri, in the United States, working as

a Freelance lllustrator. As for current work, |

An Interview with ﬂan J’w[l

MTG(Magic:The Gathering) images: © 1995-2007 Wizards of the Coast, Inc., a

have several pieces I'm working on for Magic:
The Gathering and World of Warcraft trading
card games. | was excited to get to do some
packaging art for WoW recently, and | just
turned in a batch of concepts this morning for
the Warhammer Online MMORPG. Last week
| got the opportunity to do some sketches for
the DC licensing department. | enjoy mixing in
concept art and comic art to go with the fully
painted pieces | do for the trading card games.
I think it helps keep everything fresh and

interesting.

Wow, so you're keeping busy then?! OK, so |
feel like there will be many artists out there now
who will want to kick me if | don’t ask you how
you originally got into this industry? How did
you get your first job creating artwork for trading

card games? Also, where do you think you will

subsidiary of Hasbro, Inc. All Rights Reserved.”

go on from here? What paths have opened up
for you whilst you've been working for the likes
of WoW, Warhammer, Wizards of the Coast and
DC Comics?

Well my first commissioned work was for a little
Internet collectible card game called “Chron X”.
Of course, it paid horribly, but at least it paid and
it gave me experience dealing with deadlines
and an Art Director. It also helped me build my
portfolio which | used to get, what | felt like at
the time was my big break, the Warhammer
40K CCG. Getting to work on a big name like
Warhammer was really cool and | think my

work grew tremendously during that time. My
Warhammer work got me into Magic, and so on.
Over the last few years it has been nice to have
Art Directors contact me, rather than vice versa.
It has given me the opportunity to pick and

choose jobs a little and work on things | really

Issue 017 May 2007


http://www.3dcreativemag.com
http://www.2dartistmag.com
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But, do you still sketch for fun with traditional
media, or is everything that you do now purely

digital? Do you ever feel a little guilty having left

your roots behind? Or do you feel that there is

really no difference between sketching/painting
whether traditionally or digitally? Would you say
that either way uses the same skill and has the
same feeling of satisfaction as the other?
Sadly, | very rarely pick up an actual pencil to
sketch anymore. | really need to do it more,

not only because | enjoy it but because it really

helps build your drawing skills. | don't feel guilty

An Interview with ﬂan J’w[l

MTG(Magic:The Gathering) images: © 1995-2007 Wizards of the Coast, Inc., a

for going digital because to me the computer is
just another tool for creating art. | don’t feel like
any less of an artist for using it, and if | wasn’t
using it | probably wouldn’t be able to do work

quickly or accurately enough to pay the bills.

Looking at your fantastic portfolio, | was
overwhelmed by the sheer quantity of high
quality images that you have created. Your work
is of a specific genre - fantasy, game and comic
art - so what is it about this type of artwork that

really gets you going?

subsidiary of Hasbro, Inc. All Rights Reserved.”

*

Thanks! There is a lot of stuff on there isn’t
there? | probably should narrow it down to a
more focused portfolio but it's difficult to exclude
anything because so often the pieces that | think
are weak are enjoyed the most by others. In any
event, | try to always maintain a minimum level
of professional quality even if I'm not necessarily
excited to work on a certain piece. To answer
your question, | couldn’t imagine doing any
other type of art as | don’t think it could maintain
my interest. There's something so cool to me

about bringing to life the amazing characters,
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So if you don'’t get chance the play the games

or read the comics these days, where does

your inspiration come from for all these fantastic

artworks? You have listed some great artists as
sources of inspiration on your website; however,
| wonder where else you seek inspiration from...
Is it simply a case of keeping your eyes open

to the world around you, or do you spend a

lot of time researching to inform your personal

concepts?

| wouldn't say | never get the chance to play
video games or read comics - it has just

been greatly reduced from my ‘teen’ days.

You have to expose yourself to other artists

and inspirations or you risk being stuck in a
stagnant bubble. Next thing you know, your art
is outdated and no-one wants to give you work
anymore. | use the Internet almost daily to find
inspirational art which | refer to sometimes while

working. A couple of times a year I'll take a two

An Interview with ﬂan J’w[l

or three day break from working and do nothing
but research and organise my art collection. It
can be a real inspiration and can jump-start your

creative engine.

Some people regard Superman as the most
iconic superhero of all time, who has been
immortalised by many well-known artists. How
difficult was it to give justice, and apply your own

personal stamp, to such a huge icon?
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How do you go about starting something as
huge as an artwork of Superman? Can you
give us a brief insight into your general working
process, from beginning to end?

With a painting that shows an iconic character
like him, | felt | needed to first research how

he had been depicted in the past. Quite often

there’s a little bit of research time that needs to

be put in before you even put pencil to paper (or
maybe | should say stylus to tablet), whether it
be to see what kind of plants are found in the
jungle scene you're going to paint, or to make
sure you know the proper musculature on that
horse you're getting ready to depict. In this case
| dug out several trade paperbacks | had to see

how other artists had shown him. | made mental

An Interview with ﬂan J’w[l

notes of what | liked and disliked about them
and regurgitated it all into my own personal

take on the character. As for the actual working
process, in Photoshop I'll generally block-in very
rough shapes with a large brush to get a feel for
the composition | want. When | get something |
like I'll make a hue/saturation layer with settings

Hue: 210, Sat: 85, Lightness: 85. What this does
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An Interview with ﬂm J’wll

From the FAQs on your website, | can see that
you switch between Painter and Photoshop when
creating your artwork. What advantages does
Painter have over Photoshop, for you?

Both programs have their advantages, but | really
love the feel of the brushes in Painter. The way
they blend and lay down colour feels so much
more natural than Photoshop, although | have
been playing around a lot lately with custom
brushes in Photoshop and have been really
happy with the results so far. Painter also has
the ability to rotate the canvas which can be

so handy. It really helps it feel almost like your
working on a physical board on your art table.
Photoshop is the King though when it comes to
selection tools and colour manipulation. During
the course of a painting, it's not uncommon for
me to switch back and forth between Painter and

Photoshop a dozen times or more.

That's really interesting, because you mentioned
earlier that you were frightened by Painter in

the beginning?! What was it that frightened you
so much, and how did you get yourself started

in Painter and able to overcome your fear? Do
you have any tips for artists out there who have
a similar fear of the program and are waiting for
that nudge to get them experimenting?
Definitely the interface. Coming from the
Photoshop world, all the little drawers and
options were a little foreign and intimidating.
Nothing seemed to work the way | wanted it to at
first. It took two things for me to finally get over
the hump. First, | watched a DVD tutorial where
another artist was working in Painter. Next |
found one brush that | was comfortable with and
worked exclusively in the brush without worrying
about any of the other features. Eventually |
added a second and third brush and started
tweaking some of the settings on the brushes. |
still feel like | have a lot to learn about Painter but

feel a lot more comfortable with it now.

If time were not of such essence these days, do
you think you would ditch your tablet for a good,
old-fashioned paintbrush?

My first thought was yes, but actually, I'm not so

FLAMER,

WH(Warhammer Online) images: “© 2007 Games Workshop Limited. All Rights Reserved. Games Workshop, Warhammer,
Warhammer Online, Age of Reckoning, and all associated marks, names, races, race insignia, characters, vehicles, locations, units,
illustrations and images from the Warhammer world are either ®, ™ and/or © Games Workshop Ltd 2000-2007. Used under license

by Electronic Arts Inc. All Rights Reserved.
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sure. There are pros and cons to each. | definitely
miss working traditionally and there’s a real tactile
satisfaction to slapping paint on board and having
a physical piece to look at. I've learned so much
on the digital side though that I'm not sure how
I'd survive without access to layers, quick mask,
undos, colour adjustments, and so on. I've tried
to do a few traditional paintings since converting
to a digital workflow but I've never been satisfied
with the results and it seemed agonizingly slow.

The computer has spoiled me!

So you've been completely won over by
computers - that's totally understandable! You
mentioned earlier that you grew up using Macs.
Do you still use these over PCs? This is a
debate we often have here in the studio; Mac or
PC? What are your thoughts on this for all those
out there who aren’t sure of the pros and cons of
each type or are maybe thinking about investing
in a Mac?

There’s really very little difference once you

get into the program. The biggest pain is the

WH(Warhammer Online) images: “© 2007 Games Workshop Limited. All Rights Reserved. Games Workshop, Warhammer,
Warhammer Online, Age of Reckoning, and all associated marks, names, races, race insignia, characters, vehicles, locations, units,
illustrations and images from the Warhammer world are either ®, ™ and/or © Games Workshop Ltd 2000-2007. Used under license

by Electronic Arts Inc. All Rights Reserved.

location of the Control-Option-Alt-whatever keys.
I'd like to strangle whoever made the decision to
make the keyboards different! | think Macs are
more stable computers but they also cost a lot
more. It used to be that it was a lot harder to find
programs for the Mac because so many more
people used PCs, but that doesn’t seem to be

as much of an issue anymore.

When working digitally, we talk about not having
a hard copy artwork to look at, so what steps do
you take to back-up your work and make sure
that your artwork is safe for the future, being that
you can't “hold” it and lock it away?

I've been pretty lucky and I've only ever lost
one piece that | can remember. Usually when

| finish a piece | copy it to a second computer |
use. Once several pieces have built up I'll burn
them to a DVD backup. | also usually burn a
secondary copy which I'll keep at my parents
house in case a fire were to destroy everything

at my house.

That sounds very sensible! Finally, we have a
pretty much compulsory question these days:
what one, single piece of advice would you
give any aspiring artists looking to get into the
industry today?

Be dedicated. Don’t waste your time if it's not
something you really love. It sounds like a fun
job but there is a lot of work involved. If you
really want to do this for a living then be ready
to put in 50-60 hours a week doing it. Don’t cut
corners on your work because it will show. Be
honest with yourself. If you look at a piece and
see something’s wrong with the anatomy: fix
it. It may take a lot of time and be a pain but in
the end you'll have something you're proud to
show. Oh yes... and have fun! You're painting
superheroes, goblins, and elves for crying out

loud!

Dan dcoll

For more work by this artist please visit:
www.danscottart.com Or contact him at:
danscottart@hotmail.com

Interviewed by: Lynette Clee
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“Wild West 2500” is a project that Kan has
been working on in his spare time. This month’s
sketchbook shows of some of his character
designs along with other elements of his project

work...



The Sketchbook Of

WBWhenever | have some spare

time | work on my private project, called “Wild

West 2500”, which is all about western legends
set in a distant, post-apocalyptic future. The
characters are rough, rude and brutal. One

of my personal favourites is called “Cochise”;

| drew this guy while sitting in a cafe, not
realising that | was running out of space on
my paper. However, it turned out to be OK
because it worked to make the character
appear larger, and scarier. This part for me
was the hardest, and yet the fastest. It is really
tricky to set a powerful action pose without
using any reference material. After about one

hour the line work was done, and so | started

rendering some simple and neutral shades,

and applied little details like scratches and tattoos. | paid good attention to the shrunken heads
that | felt this character would probably have killed, or even eaten. Since | had my values done
for the drawing, | started with the colouring in Painter. | had some weird, strong colours in mind,

like cyan and pink. Everything at this point was painted with a chunky, oil brush. | received some

friendly tips about the
cropping, but these were
obviously wrong. Realising
the error with the cropping,
| repainted some elements
and gave the figure more
space to fly. From this point
on, | painted everything
above the drawing layer.
This caused me to lose a

lot of the detail, but gave

the image a certain “oily”
look. Increasing the contrast

also helped to separate the

figure from the background.
| brought back the red by
painting it in but did not
‘colour adjust’ it, and so it
hints at the underpainting

- which is quite a cool trick!
It took me about seven
hours to complete the whole
painting. There are many
people out there who I'm
sure could do it much faster,

but | like to take my time...
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ﬂaﬂon MEZIldHere | approached the task completely

differently. This one is a 100% digital sketch made in the new version of
Painter. | learned my craft in an old eastern European school of fine art;
| remember coming home with lots of dirt on my brand new sneakers,
or having chunks of clay in my hair. Painter is one of the very few digital
tools that can bring back the feelings of those good, old, smelly times.
| absolutely love to play around with Painter’s oils, just like | have with

this piece. Although | can’t draw digitally

nearly as good as | can
with a ‘real’ pencil, |
tried to make the sketch
correct on the computer.
As you can see, it looks
like it has been drawn
with a foot, but that’s
OK. | didn’t want
to have any trace
of drawing in this
piece; just a little
guide for my wide,
oily brushes. As
for the character,
it's one of my
“Wild West 2'500”
reincarnations

- one of the
Dalton brothers.

I had this idea

of a stupid, yet
dangerous,
Redneck;
caughtin a
moment just before pulling out his gun. | wasn't happy with

the first sketch, so | made a second one. | couldn’t let go of those little
skulls and so they feature here again, sitting on his shoulders. | drew
him with one gun in his left hand, and drew the other one with his right
hand. | applied values, but kept them very simple. | wanted it to look like
one of those very old photographs, yet with a lot of energy contained

in it. I made a decision to get rid of the skulls - it was a stupid idea
anyway. | continued and defined the costume, but forbid myself to use
a smaller brush. Any mistakes were covered by a new brush stroke,
rather than using Undo, which gave the underpainting “air to breathe”.

| couldn’t resist some basic colouring of the skin, and so increased the
values. | also find yellow to be very attractive, and so, without much
thinking, | simply splashed the paint on and called this one finished.

This was a very fast one, which was made in around two hours.

The Sketchbook of Han Hlufflic
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”pﬂll'll# This was going to be used in
a music video as the very first shot. Since |
co-directed this video, | had a full freedom to
design whatever | wanted, and so | decided
to go somewhere between Judge Dredd,
in terms of its design, and Ghost in the
Shell, for its neatly drawn aesthetics.
First of all, | opened up my sketchbook
and started drawing lines, with the

help of a ruler. | knew that | wanted to
make the building in the background
huge, and so | played with the
perspective a little, without making it too obvious.
After about two hours, the drawing was done. | scanned it in and took

it into Photoshop, where | gave it a main background colour, executed with a brownish

gradient below the drawing, and set its layer mode to Multiply. Next, | gave it some basic values.
To be honest, | didn't worry much about the light at this moment, since | knew there were going to
be multiple lights, and | didn’t want to think too much in advance. As | mentioned before, once the
lights were set the situation got a bit tricky, but | aimed to keep it all as simple as possible. Neon
lights gave some glow, edges received some highlights, and the colours were chosen to really
stand out, like in Japanese anime. Finishing the piece was fun. Textures were added using custom

brushes; pushing levels and playing with the Dodge tool until they were where | wanted them to be.
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Nlid Level
There is rarely such
a pleasure for me
as when | sit down
in a cafe, pull out
my sketchbook

and dive into the
drawing. And this
was exactly how |
created this piece.

| was supposed to
make a background
for a pretty
important scene

of a music video,
which | mentioned
before. It's a long
scene with some
characters involved,
so | knew this had to be good “eye-candy”.
Since | settled the architecture with a rusty,
futuristic look, | had to keep that as a style
guide. | started to draw organic shapes
which were similar to bones. | then made
some mechanical parts and came up

with a terraced wall at the end. | took the
drawing into Photoshop and firstly created

a silhouette of the wall. | needed to read

www.2dartistmag.com

The Sketchbook of Han Hlufflic
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the shape well, since it's quite abstract. |
then made a layer of its base paint. The
two-colour pattern works very well on
architecture. Without thinking about values
at this point, | just hit some edges with the
small highlights, which is not quite the right
way to do this but | just did it anyway. The
next thing | did was to duplicate the image,
and then mirrored it. | wanted to get the best
out of those shapes, and so | experimented
with it for a while. | also painted a simple
sky gradient to achieve more feeling for
the terrace. Finally, | drew and painted the
skyline in the background, and pushed the
contrast a little higher. It's obvious that |
used one fragment and replicated it, but |
believe that it works quite well in the video.
It took me about five hours to complete this

painting.
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Jﬁiﬁvl love

designing vehicles
of all kinds, with
hovercrafts being
my all-time
favourites. For
this particular
design | had

a shape of

a fish in

mind; one

of those

huge, exotic
fish (whose name | can’t recall
now). It should be just like that fish: full of scars

- heavy but powerful - and perhaps some kind of a combat ship.
| drew this one without using references of the fish that | had in mind, but |

think | matched it quite closely. Anyway, it didn’t take me too long, perhaps just half an hour

or thereabouts. | painted in the scratches and the parts of the engine that would be seen; perhaps
they fell off due to the bad conditions? The base paint was applied to give it a ground colour to work
upon. Combining colours that | wouldn’t normally put next to each other always gives me surprising
results, and in this case also gives a certain rhythm to the shape. Applying textures with a custom
brush, and setting logos and decals, helped me to achieve the realism of the vehicle, and just
makes it look so much better. Below is how | present my designs to clients. It's always nice to have

some kind of a stripe in the background, but it shouldn’'t compete with the design itself. Also a small

description helps to sell it. There is a little trick
| use at the very end of the process: | flatten

the image and then apply the Sharpen filter on
it, which creates some extra detail and gives a
nice crispness. Don’t do this with files that you
want to print, as it'll just get messy. This whole

process took me around two hours to complete.

For more information please visit:

http://www.streamatica.ch

Or contact: info@streamatica.ch
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Anime

Follow this excerpt from the book “Making Anime”, which provides

essential animation skills in making anime; create mesmerising
manga-style animation with pencils, paint and pixels...
melthods forn animalion have
nol changed much over the
cenluny, bul many of the
lools involved have evolved
considenably. ~



Essential Animation Skills

paper typically has three holes punched in it to make sure it aligns

Mal(ln perfectly with the previous and subsequent frames. By placing the

g paper on a pegboard, it is possible to flick between animation
n I me frames to ensure a smooth transition.

It is common for animators to fasten a pegboard to

E 5. g m . a. J‘ .ﬂz their flatbed scanner to guarantee each frame of

animation is perfectly aligned when

Although the vast majority of today’s animation o .
digitized. This speeds

is created digitally, basic drawing and animation )
up the scanning

skills are still required. Computers can reduce )
process and avoids

the amount of work, especially for repetitive
unnecessary errors

or labour-intensive tasks like painting, but .
or adjustments.

they cannot replace essential drawing skills. . )
Professional studios

The following pages cover a variety of basic )
use scanners with

animation techniques that can be applied to )
sheet feeders (like

any 2D animation, whether it is hand-drawn .

on photocopiers)
on paper or input digitally with a graphics

and software that

tablet and stylus. By mastering methods such ) .
automatically aligns the peg

as key frames, walk cycles, facial animation, hol
oles.

lipsynching and sound, as well as easy ways of

achieving the same effects with minimal work, -
g pma&/ MMM Mechanical pencils are recommended for animation work

you will be able to create professional-looking . . .
because they are clean and reliable, with a consistent stroke. You should opt for the softer grade

animations. ) ) ) ) o
pencils, as a lot of adjustments may have to be made to each image to ensure the animation is

perfectly smooth, which means a lot of erasing. Soft putty erasers are a good choice, since they do

The basic production methods for animation .
not leave residue on the paper.

have not changed much over the past century,

but many of the tools involved have evolved ) ) ) ) )
Some animators use coloured pencils for certain parts of their frame, such as marking the “cel-

considerably. The integration of computers into ) o ) ) . )
shaded” area of the image. This is picked up later during scanning and is used as a guide when

the workflow has reduced labour in certain areas .
colouring the frames.

of production and allowed more time and energy

to be focused on the animation itself. Whatever - )
WMThe lightbox

method of production suits you best, be sure to ) ) .
is an essential tool for producing

choose the correct tools for the job. ) ) )
animation on paper. By placing the

p ‘ & ! m . a. paper on the lightbox, it is possible to
see several frames of the animation
@PLNR \\hen producing animation on

paper, you need to use a pegboard. Animation

at once, making it easy to predict
where the following image should be.
Pegboards are used here to ensure
each frame is aligned correctly.
Lightboxes designed for animators
feature a rotating disc that makes

it easier to draw when the paper is
fixed to the pegboard. Animation
software for computers often

emulates the use of a lightbox with a

function called “onion skinning”.
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lnimalion (ebs and Painls

Traditionally, animation is produced on sheets
of clear acetate called cels. The line art from
the individual frames is copied on to transparent
sheets and paint is applied to the rear side of
the image. This technique has become less
common with the advent of digital animation,
but it is still used by many animation production

companies.

Digilal 3till and Video
WDigital cameras have a number
of useful purposes when producing animation.
First, they can help provide reference material
— you can film movements of yourself or a friend
from different angles and then play it alongside
your animation. It is easier than using a mirror

and doesn’t have to be perfectly lit.

Hlaking lnime esseniial Animaton Skils

Nnag.com

Secondly, the footage can be used as the basis
for the 2D animation itself, using a technique
known as “rotoscoping”. Rotoscoping involves
tracing the movement of a person from existing
footage to create very accurate 2D animation.
It was originally done by projecting the frames
of a film through a lightbox, but modern digital

solutions make it much easier.

Finally, digital still cameras are a great way
to get reference images for backgrounds,
environments, household items and any number

of other objects.

Shoot the scenes and objects from as many
different angles as possible to take full

advantage of the medium.

(ompalens and doftware
Computers are now the mainstay of anime.
They have made it much easier to produce
professional-looking animation, even for first-
time animators. Software like Flash and Toon
Boom Studio has simplified the process and
made it easy to create a short anime to show
on the web. Nearly all animation software
is available for both Apple Macintosh and
Windows machines, so your choice of computer
will be down to personal preference and
budget. A large monitor and fast processor are
important, so an Apple iMac would be an

excellent choice, for instance.

page 45

The most important peripheral to get is a
graphics tablet. These come in a variety of
sizes and prices, with Wacom being the market
leader. This tool will allow you to draw directly
into the software, as if you were using a pen,

and is a more natural way of working.

L 4 d
lnimalon & Iip: Using a
Many animators use mirrors,

either on their desk for facial expressions or

full-length ones to see body movements. It is
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Essential Animation Skills

much easier to get animation correct when you
have a good reference and are certain of how a

character should move.

Essenlial Shills

- Break figures into basic shapes

- Keep detail to a minimum
It is an age-old lesson in art theory that
everything we see can be broken down into
simple geometric shapes that make up the
very essence of their form. The human body
is a complex structure, but if you think of it
as a collage of spheres and cylinders you
will find it much easier to mentally digest
and subsequently draw. This technique of
sketching out a “mannequin” has always
been synonymous with comics/mangas and
animation, and is very helpful in conveying core

ideas before finalization.

Dhawing a llale figure

1. Basic-shapes mannequin

You may wish to create stages 1 and 2 by hand,
and then scan the sketches into a computer

for inking and colouring. If you are working on

a computer, open Photoshop (or the digital
imaging software of your choice) and start by
outlining the character pose using basic shapes.
Since the human body is relatively curvaceous,
it is a good idea to stick to using simple circles

and oblongs to construct the overall shape. Bear

—Line of action

1 2 3

in mind that you are building a male character
and make sure that the proportions are set
accordingly, with wide shoulders and straight

hips.

2. Rough sketch

Create a new layer on top of the mannequin
and do a rough sketch over it. Details are not
important at this point, just treat it as a pencil
sketch and get the basic ideas down. To get a
nice pencil feel you may wish to reduce the flow

or opacity of the brush to 50%.

3. Erasing the mannequin
Once the sketch is in place, you can delete the
mannequin layer (or you can just leave it and

instead toggle the visibility off).

4. Digital inking

Depending on how much time you wish to invest
in the piece—bearing in mind that you will be
doing this frame by frame—start digitally inking
in the sketch on a new layer. Keep the detail to
a minimum (no more than what is shown in the

example).

5. Adding colour
Create a new layer (or a separate layer for each
colour) and begin filling in the base colours.

For advance masking techniques, refer to the

4 5

“Masking” panel over the page. You may wish to
tweak the colours with the Hue/Saturation tool
until you are satisfied. Try to keep your colour
palette simple, as it is both easier to manage

and visually more cohesive.

6. Cel shading

Now create another layer(s) on top of the base
colour layer(s) and begin the shading process.
The anime cel-shaded style requires sharp
precise block shading to be implemented as in
the example. Avoid using soft brushes, as it is
much easier to animate blocks of colour rather

than indistinct and vague “clumps” of colour.

Animator’s tip: The line of action

The line of action encapsulates the dynamics of
a pose — it's an imagined line which goes inside
the figure. For some animators, it is the first
mark they make when drawing a moving figure.
The body parts are hung off this line and reflect

its direction.

6
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Dhawing a Jemale figure

1. Basic-shapes mannequin

The procedure here is essentially no different
from that of drawing a male figure. Sketch out the
mannequin in your desired pose. This example
depicts a slim, model-like character, posed as if

walking down the catwalk.

2. Rough sketch

Create a new layer on which to lay the rough
sketch. Avoid spending too much time fussing over
details at this stage — just try to get a good sense of

the overall composition.

3. Erase mannequin
Delete the mannequin layer (or leave it and toggle

the visibility off).

4. Digital inking

Begin digital inking. Avoid too much detail, as the
higher the detail the harder the character will be to
animate later. The detail shown in this example is
probably too much for long-haul animation — you
may want to counter this by reducing the amount
of crease marks in her clothing and the detail of
the hair. However, as a still shot, a highly detailed

frame like this can be visually arresting.

5. Add colour
A limited colour palette has been used. The simple
combination of pink, black and white is effective

and appealing.

6. Basic-shaped mannequin
Apply cel shading and finishing touches to

complete the piece. Keep details to a minimum.

Wasking
Using a “mask” is not compulsory to the cel shading
process, but it can be a very handy technique to
employ in order to raise efficiency. Essentially the
virtual equivalent of masking tape, the mask tool in
Photoshop (or any other advanced imaging software)
can help section out specific areas of the image
permanently, saving you the trouble of reselecting/

deselecting over and over while applying cel shading.

Mill} Lnime Essenial Animation Skils

4
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Essential Animation Skills

1. Choose the “Magic Wand” tool and select the
desired area to cel shade. When the selection

is made, go to the top menu and choose
“Select>Modify>Expand” and apply a 1-2 pixel
expansion. This is important because the magic
wand does not go right to the edges of the line
art. By expanding the selection, you are making
sure that the colours you later implement will
bleed right to the edges. It should be noted that
this method is only applicable to selections that
are totally sealed off. If there is a gap in the line
art, the magic wand will not accurately make the
selection. In this case, simply use the “Polygon
Lasso” tool to make the selection manually 1

instead.

2. Create a new layer underneath the line art that
is to be the coloured layer. With the desired area
selected, click on the “Add Layer Mask” button
located at the bottom of the “Layers” window (a
black box with a white circle in its centre). Now the
area is sectioned off by the mask and anything
outside the mask is immediately non-visible. The
exact area of the mask can be seen by pressing

the Control and Backslash keys together.

3. Add in the desired colour and let the mask

do the rest. You may need to amend the mask
slightly at this point, since the magic wand tool

is fallible and might not pick up the tight corners
very well. The mask can be modified by selecting
the mask property of the relevant layer (the black
rectangle to the right of the original layer image).
Now you can add to the mask and cover up more
of the image by using a pure black brush, or
delete some of the mask by using a pure white
brush. Any tones inbetween will result in a mask

of half opacity.

Is a chapter excerpt from the book: Making
Anime

For more information please visit:
www.focalpress.com

Article Courtesy of: Focal Press, an Imprint of
Elsevier Copyright 2007 Making Anime: Create
mesmerising manga-style animation with

pencils, paint and pixels.
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Make your own anime with this unique introductory guide

to Japanese animation. You'll learn every stage of the
animation process from scripting and storyboarding to
preparing and distributing your film. Everything is clearly
explained with step-by-step tutorials and packed with
colour screengrabs, stills and artwork illustrating every
technique and process, including: hand-painting
characters and backgrounds on to separate cel layers;
working with 3D graphics; using digital pen-and-tone

techniques.

Apply the core style elements and visual language
of anime to your own work and learn to: simplify
characters without losing their impact; create
exaggerated facial expressions; use shadows and
shading for dramatic effects; and add lip syncing

and speed lines to convey movement.

Richly illustrated in colour the step-by-

step tutorials show you how to hand paint
characters and backgrounds onto separate cel
layers, use digital pen-and-tone techniques

and work with 3D graphics.

You'll master the core style elements
and visual language of anime and create
exaggerated facial expressions and use

shadows and shading for dramatic effects.

ISBN: 978-0-240-52045-2: ISBN10: 0-240-
52045-9: Book/Paperback

Measurements: 215 X 280 mm:

Pages: 128

Imprint: Focal Press

Publication Date: 23 October 2006 Price: £13.99
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Streamline your DI pipeline
with the SBDBOXX™ RTX Series.

Next-Generation AMD Opteron™ processors with DDR2 memory
extend the industry-leading performance trajectory established by A M D
Dual-Core AMD Opteron™ processors, while offering a seamless
upgrade path to Quad-Core performance and leading-edge
solutions to help run your business applications.

Next-Generation AMD Opteron™ processors with Direct
Connect Architecture and high-bandwidth DDR2 memory
offer great performance for floating-point applications and
enhance our performance-per-watt capabilities for even
cooler, more silent operation.

Opteron-

BOXX® Technologies, Inc.
1.877.877.BOXX
sales@boxxtech.com

We know VFX. And it shows.

www.boxtech.com



http://www.boxxtech.com/products/3DBOXX/RTX_Overview.asp

2DArtist Magazine introduces the new
‘Challenge’ Section of the mag. Every
month we will run the challenges available
for anyone to enter, for prizes and goodies
from the 3dtotal.com shop, and to also

be featured in this very magazine! The

2D Challenge runs in the conceptart.org
forums whilst the 3D challenge runs in the

threedy.com forums. Here we will display

the winners from the previous month’s

challenge and the Making Ofs from the

month before that...

InFASSOCIationawith



http://www.conceptart.org/forums/forumdisplay.php?f=74

Stylised Animal Challenge

yhed Al Crelery

The lhallenge

Welcome to the Stylised Animal Monthly

Challenge. Each month we will select an
animal and post some images in the Forum
Thread for your reference. All you have to do is
create a 2D image of this creature in a stylised
/ abstract / cartoon style, whilst keeping your
creature instantly recognisable. We wanted

to publish some content in 2DArtist Magazine

about how to create stylised animals, similar

h h in fe fil
to those that you may see in feature films and EM« ym

cartoon galleries, and we thought that this

regular competition might just bring in the images / Making Ofs that we
need, whilst also giving away great prizes and exposure of course. If

it continues in success we will try to carry on boosting the prizes up as
much as we can! This month’s animal was the ‘Eagle’. Here you can see

the top 5 placed entries, as voted for by the public...

UWhal are we looking for?

Funny and humorous entries which break the animal down to its most
recognisable components; emphasize these features in whichever ways
you think best, and render your stylised / abstract / cartoon masterpiece.
The rules are pretty laid back: please submit 1 X 3D render (minor post
work is OK); it’s up to you if you want to have a background or if you want
to include some graphical elements or text on your image. Renders of the
800 pixel dimension sound about right, but the winners will be featured in
2DArtist Magazine, so if you can create some higher resolution images
too, then all the better! There will be one competition per month, with

the deadline being the end of the month (GMT). For a valid entry, simply
make sure your final image is posted in the main competition thread
before the deadline. We require the top 3 winners to submit Making

Of overview articles that will be shown on either 3DTotal or in 2DArtist
Magazine. These need to show the stages of your creation - different
elements and some brief explanation text - of why, and how, you did what
you did. We will format this into some nice-looking pages to give you
some great exposure, and us some quality content. Each competition will
have one main thread which starts with the brief at the top. All entrants
should post all WIPs, give feedback, and generally laugh at the crazy

ideas that emerge each month...

sth zsth Wing
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Stylised Animal Challenge

ylh &inen
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Stylised Animal Challenge
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Stylised Animal Challenge

Lhallonge Thnead

The 2D ‘Eagle’ challenge can be viewed here

The challenge now at the voting stage is:
e, L4

lnlealen

The current challenge taking place is now:

Inail’

To join the next 2D challenge, or to view the
previous ones and/or the current entries, please
visit:

www.conceptart.org

If you're also interested in the 3D challenge
please visit:

www.threedy.com

Or contact: ben@zoopublishing.com

37 (hallenge

Here are last month’s top entries from the 3D

competition...

znd lulhentic

18l Papumash
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Stylised Animal Challenge

Hlaking Of 5

Here are the Making Ofs from last month’s top 2 winning entries...

znd - Janos Kiss
MM&W At first | attempted to catch the peculiarity of

the camel, and so | downloaded some reference photographs and made
preliminary sketches. | decided to depict my camel from a side view, and
played around with the proportions of the strange animal. | chose to work
with a long form; a big head, small body, long and slim legs, with tired

eyes to evoke the emotion of the character (Fig01).

”hMI thought that a clean, smooth, vector-based, comic-like

solution would be great for this theme. | scanned my chosen sketch, made
some corrections by playing with the brightness and contrast settings,

and then imported it into Corel Draw. | first locked my scanned image’s
bitmap layer to protect any accidental moves or drawings made upon it.

In the next step | created an outline layer, where | traced the contour of
my sketch (Fig02). | tried to solve it with as few nodes as possible, and
developed the form with control points. | modified the back leg and cut out
the unnecessary parts on the legs. | then drew the inner details, but not
too many; the mouth, nose and eye, plus some lines for the ropes and
tail. Next | combined the lines together, gave an average thickness and
expanded them (go to “Convert Outline to Object”). | copied the remaining

contour to another layer so that | could colour it later on, and then began

Fig01

Fig03

Fig02
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to edit the outline’s nodes and
control points to simulate inking

(Fig03).

-
MMI chose a brown

and a yellow-brown for the basic
colours, and made a gradient fill
colour. | began shading to define
the camel’s forms using yellow
and brown. | started with the head
and the eye, then moved on to the
body, and finished with the lower
parts. Instead of using a blend
tool | used the transparency tool
to make transitions between the

objects and their colours (Fig04).

Fig05

Stylised Animal Challenge
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Jdanos Kiss

www.28thwing.com

janos.kiss@?28thwing.com




188 - Pabri Balanovshy
| started by sketching the camel, all the while
keeping in mind the quirky and distinctive
characteristics and features that make up a
camel; the long face, lazy eyes, hanging neck,
big toes, and those wobbly legs with their
bulging kneecaps (Fig01). On a new layer set
to Multiply | painted in a solid, flat sand-like
base colour, using a brown/grey (Fig02). |
painted in some shadows and curves; pushing
and pulling the values whilst further cleaning
the forms (Fig03). On another layer set to
Overlay | warmed my basic colours up a little
by painting in some yellows and light oranges. |
then painted in the camel’s eyes and gave him

a shaded beard using a blue-green colour. |

kept on pushing and pulling the forms, “carving”

out the camel's shape and body. With some
white paint | went on to cover over the back
legs to make them fade into the background
slightly (Fig04). | kept warming up the browns

and oranges with more solid Overlay layers

Fig03

Issue 017 May 2007

Stylised Animal Challenge

Fig02

Fig04


http://www.2dartistmag.com
http://www.2dartistmag.com

Stylised Animal Challenge

J—————— f yellow colours. |
Fig05 . )

then painted in some
fur and hair textures
using a custom brush
on the camel’s head,
neck, back and hump.
| painted a purple/blue
stroke around the
character to frame
him, and painted a
drop shadow upon the

ground. Using some

T T T T T W T W W W W W W W N W W TwTw

selected textures,

| created an old,
middle-eastern looking
window frame for the
far background. At this
point, | also created

a sand-coloured,
half-tone pattern on
top of my image on a
new layer, which was
set to Darken. Using
the quick mask tool |
erased this new layer’'s
central part away
from where my main
figure was (Fig05).
Using a green/blue
colour | lightly painted
the camel’s belly,
neck and toes. | also
added a little tail,
which | forgot to paint
earlier, and created
some arabesque-like
decorative lines using
the Pen tool to frame
the whole piece.

Finally, using a new

Overlay layer of solid,
| orange colour, with

Il its opacity lowered to
il about 10%, | warmed
my whole image even

i
i
| further (Figoe).
I
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Pabni Balanovshy | | |
For more work by this artist please visit: ‘-\j
http://chuckmate.blogspot.com

Or contact them at:

Pat2005b@hotmail.com
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Geans off Wan Prison Indusbha

John Wallin Liberto / www.johnwallin.net / info@johnwallin.net B. Borkur Eiriksson
This image is copyright of Epic Games : www.epicgames.com www.borkurart.com
Game site : www.gearsofwar.com borkur@ccpgames.com
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David Smit

www.davidsmit.com

David@davidsmit.com
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b 10 of the Best

Summon Inflinily

Lauren K. Cannon
http://navate.com

Ikcannon@comcast.net

Follow the ‘Making Of’ this image in the next issue of 2D Artist magazine!

Rise
Roy Stein

Www.roystein.com

roy_splinter@walla.co.il
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laisha

Joe Slucher

www.joeslucher.com

slucherj@yahoo.com
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lan l prevenl i,

bul there is no need to prevent

Ryohei Hase / www.h4.dion.ne.jp/~ryohei-h/index.html
ryohei_hase@f6.dion.ne.jp

Follow an in-depth interview of this artist in Octobers issue of 2D Atrtist

magazine!

Hlecha Dniven
Danny Antivalidis

www.ikuru.se

danny@ikuru.se
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Zaaa Lastle cusomBrushes

Orealed In:

Photoshop

Whal are Luslom
Brushes?

Most Photoshop brushes are made from small
bitmaps that are used like stamps to make
marks on the digital canvas. Much like potato
stamps on a piece of paper, the raised, inked
parts of the potato stamp are like the black pixels
in the bitmap. You can control the way that
Photoshop uses these ‘stamps’ in many ways.
For instance, set the scale, rotation, scattering,
opacity or colour of a brush to “random” and you
get a mass of dots or blotches, or if you control
them with the “pen pressure” you can achieve a
smooth brush-stroke - all from the same bitmap,
as you can see in brushes 8 and 9 below. There
are enough variables to play with to keep you
exploring forever, and each time you experiment
and save what you have made, you have a new

custom brush.

How do 1 Make a Luslom
Brush?

There are many approaches to making custom
brushes; some brushes are made using bits of
photographs whereas others are painted for a
purpose - there are no rules. In this tutorial, |
am going to cover how to make some brushes
from scratch, by painting your own brush tips...
To make a brush, firstly create a new image

- usually quite small to keep the strokes fast.
Each time the computer stamps that picture
on to your canvas it's crunching numbers, so
smaller is quicker. Once you have this new
image, paint some marks on the canvas: go
wild and experiment - you can always delete

it if it doesn’t work. Once you have made a
few images and tried to paint with them you
will get a feel for what works and what will be

useful, but for the moment make it a few simple
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dabs or a pattern, or even your
signature! Then, when you have
painted something you are happy
with, go to Edit > Define Brush
Preset, give it a name, and it will
be added to your brush list. It is
still a very boring brush with the
default settings applied to it, so
start playing with the settings in
the Brush Palette. Fiddle with

all the settings to get an idea of
what they do and soon you will be
making some amazing brushes.
You can find the Brush Palette by
going to Window > Brushes if you
can't see yours on-screen already.
Lastly, be sure you save it! With
the brush tool selected, right-click
on the canvas to bring up the
brush list and save the brush by
pressing the little icon in the top,

right-hand corner.

Why Would ] Mleed
luslom Braushes?

Before custom brushes came

to be, Photoshop artists were

still happily painting away and
creating beautiful images, but they
all looked very digital and similar
to each other. Custom brushes
allow people to make their own
marks and take more creative
control. In my work as a Matte
Painter and Texture Artist, custom

brushes allow me to create detail

very fast and efficiently without

having to paint every dot and
smudge. They allow me to work
fast and effectively, but they are
not just for work. In my free time

| use them to make interesting
marks and shapes that sometimes
turn into people or places, or in
the case of this tutorial, a strange
building over lava. | love custom
brushes as they bring nature’s

randomness into my paintings.




Zaaa Lastle cusomBrushes

When and Whene Should 1 Use Luslom Brashes?

When | started working on this tutorial, | decided to create a set of brushes from scratch and to
make a painting using only my new set. Some brushes turned out to be incredibly useful, but some
others were never used. | hope you learn something from my experiment - | certainly did, and |
recommend everyone to try doing the same thing. Right, here is a list of how | used each brush
(images of the brushes can be seen on the previous page), and my reasons for creating them:
Brush 1: | started with this brush, as it is the most basic Photoshop brush and has been around
since Photoshop began. It is just a simple hard, round brush and as such can be useful for sharp
details, though in this case | only | used this to create custom brushes 4, 8 and 9.

Brush 2: This is the same as the first brush but with “wet edges” set in the Brush Palette. | used this
one to create brushes 3 and 5 and to do some detailing. It is a nice, crisp brush and is very fast for
quick sketching, but it is very digital looking and isn’t really much of a custom brush.

Brush 3: With this brush, | decided to have a bit of fun and make a blotchy pattern. | ended up
finding little use for it in this image, despite really liking it in the beginning. | sometimes make
brushes like this, but never really find a use for them and soon delete them. You have to throw them
away if they don’t work!

Brush 4: Here you can see the brush used as a motif, or symbol, on the floor. | painted a single dab
on a layer, transformed that into perspective, and then painted over it. | wanted something curly and
symbol-like, as | like to leave traces of writing or symbols showing though in the final image. This
one pops up all over the place in the finished painting. The whole composition was in fact inspired
by the shapes made using a very blown up brush stroke with this brush. | personally enjoy using
writing and symbols in my own artwork, which is possibly a bit of my graphic design background
coming through! You need to find what works for you and have fun with it.

Brush 5: This brush was meant to be the workhorse of the library. It is a simple brush with a tip
similar to a real brush, with its opacity controlled by pressure. This brush allows for subtle blends,
sharp details and is a fantastic all-rounder. If | was to make an image with just one brush, this is the
kind | would choose. | used this brush for general painting and detailing all over the image. Here
you can see the subtle values in the windows and the sharper edges of the building, which were
both achieved using this brush.

Brush 6: Here you can see how this brush was used to paint the subtle transitions and fine details in
the clouds. This brush is the blender of the tool box. With this brush, | can create subtle gradients,
glows, clouds and haze. It was my cloud brush of choice, especially as the edges it makes feel very
cloud-like, so much of the subtle work is done for you.

Brush 7: Here you can see how this brush creates ground so that it feels flat in perspective. It's a
great landscape brush which is similar to one that | use a lot in my paintings. This brush is a very
useful brush for landscapes as it makes everything that you paint feel like it is on a ground plain in
perspective. It is also very useful as a general brush because it leaves very interesting streaks and
marks behind and feels quite painterly. It is also particularly good for rendering reflections on flat
surfaces, as shown on the path leading up to the front of the building.

Brush 8: This brush ended up not being used much, but that was mainly due to the subject matter.
Were | to paint a tree, water streaks or reflections on a chrome pipe, it would come in pretty handy.
Brush 9: This one was made with the same brush tip as brush 8, but has its rotation set to “random”
so that it creates a field of random dots. | didn’t use this brush much either, but again, that is due

to the choice of subject. A brush like this is gold when you have to paint gravel or textured rock. A
combination of the streaks in brush 8 and the dots in this brush can create some amazingly life-like

textures when they are layered over each other. | also create paint using only those brushes.
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Zoo Publishing presents the new issue of 3dcreative
magazine: a downloadable monthly magazine for
concept art, digital & matte painting for only US

visit WMW.3dcreativemag.com
to download the free ‘lite’ issue, the full issue, subscription ﬁ
offers and to purchase back issues. AT
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Welcome to the Speed Painting section of the
magazine. We asked two artists to produce a
speed painting based on a simple, one-line brief.
Here we will feature the final paintings and the
overview of the creation processes. This month,

Richard Tilbury and Levente Peterffy tackle:




Orealed In-

Photoshop CS2

Build your confidence in just an hour: Levente
Peterffy shows you how to whip up a ship hit
by a torpedo with just a few digital strokes...
Speed painting is an effective painting practice
to achieve good composition, colour and light-
interaction with shapes and forms, and with

the use of brushes - both default and custom

- you can quickly create and simulate a realistic
environment with just a few strokes. The topic
“Ship Hit by Torpedo” reminds me of World
War II; | don’t really know why but | have always
been interested in World War Il and | was
therefore quite taken with the topic set for this
challenge. There are probably a million stories
to tell about that period, which would all be very
interesting to illustrate, and in this case is a
ship being struck by a torpedo. In this tutorial,
the focus on this article is that realistic images,
or colours if you like, can be achieved with the
use of custom brushes and blending modes in
Photoshop. The software used to create this
speed painting were Photoshop CS 2 and a

Wacom Intuos 2. Let’s begin...

Backgnound Loloan

| started off with a coloured background, as you
can see in Fig 01. On this background | started
to paint with custom soft-edged brushes (see
brush example in Fig 01), often with a very low
opacity of between 10-20%. | worked in this way

until | could see some shapes evolving (Fig 02).

At this stage | started to develop more of the
shapes from the previous image which were
slowly forming. Already, at this stage, one

can see that it shows the shape of a ship in

Fig01
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Fig05

the foggy atmosphere. | used similar kinds of
colours to define the shape of the ship more
and more (Fig 03). When | first had my shapes
defined | started testing some new colours

out. | used a light blue in this case for the

sky, and also defined the horizontal sea-line.

| used a simple gradient to make the ocean.
The colours were all picked from the painting:
one light colour and one darker (Fig 04). |
cropped the image at this point, and at this
stage was able to start going into more detail.

| picked a small, hard-edged brush (see Fig
05) and started adding details on the ocean,
and some smoky clouds (Fig 06). | flipped my
painting horizontally a lot, helping to refresh
my eyes and so | could see if there were any
flaws (proportions, perspective, and so on). |
continue adding details and also building on
the background, trying and testing hues of blue
for the sky (Fig 07). There is one thing | usually

try a lot, which is duplicating the painting layer,

Fig04

Fig06

Fig07
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Fig10

using a photo filter on the duplicated layer and
increasing the density on the warming filter to
85, then choosing Multiply as the blending mode
for the duplicated layer on top. To finish it off |
took down the layer opacity to a fairly low level
until | felt that the colours were just right. If you
want more control you can erase parts of the
top-layer, as | have in Fig 08. At this stage |
added some more detail to the ship. There is an
open crack on the ship’s hull, just as if a torpedo
tore a hole into it (hence the topic for this speed

painting) (Fig 09).

Deluibing
| like adding details. Adding details is kind of
like adding more words to a story, and there are
those details that you just simply have to add
because they help the picture to make more
sense, for example breaking waves, reflections
in the water, and so on. | painted a silhouette

of a bird on the left, because | felt that the sky-
area in that section was a little empty. Another

detail which | realised would help was the use

Fig12

Fig13
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of a rusty texture - look at the ship’s lower part.

| wanted to create something rust-like, so |
painted with a custom-made brush which slightly
resembles rust (see brush example on previous
page) (Fig 10 -11). | continued adding more
strokes to the smoke (Fig 12).

Loboun Test

These last stages of a speed painting are to
basically test the colours to see if you can
improve them and add more to the mood (Fig

13).

dinal Tweaks

Adjusting the resolution and adding sharpness
are the last things that | do to my paintings. And
there we go: finished (Fig 14).

list Tips & Fecnels

| can'’t stress this enough but “practice and

practice more” is the key to success. Even



with cool custom brushes as assets, you still
need to train your eye to see shapes and
colours interacting with light, in order to evolve
a painting. Try not to get too dependent on
tutorials; dare to experiment a lot, even if you
don’t know where to start, just scribble around.
There are a lot of forums out there with speed
painting threads, so post your work a lot and
see what feedback you get. There are people
out there willing to help you so use their advice
wisely. However, do try to think of the problem
for yourself, and try to solve it as best as you
can. If you have a hard time starting to paint,
then make studies from master paintings or of
screen-shots from movies - that should help to

get you started at least.

Levenle Peterflfy

For more from this artist visit:
www.leventep.com

Or contact: Ip@leventep.com
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Speed painting is a very useful way of quickly
establishing aspects of an image such as the
composition, colour scheme and lighting, and

a method of clarifying the mood of a scene,
whether it be for a film, computer game or
simply a digital painting. Depending upon the
artist in question, the notion of a speed painting
can have different connotations. In some
peoples’ eyes the idea of a speed painting can Fig01
be 45 minutes or so, whilst others may consider
2 or 3 hours spent working on a piece as a short
span of time. In the following exercise | have
tried to limit myself to a couple of hours and
have chosen to focus on the moment at which a

torpedo slams into the side of a destroyer! ...

Blocking In

As is my usual approach to any painting, |
firstly conduct a search for as many reference
images as | can find on the Internet. In this
case | gathered a number of photographs

of battleships in order for my image to look
convincing. As the ship was going to be the
main focal point | wanted to make sure it
resembled its real counterpart quite closely.

As | was looking through photographs | liked

the camera angle of one of the ships and
decided to use it in my painting. The first stage
involved roughly blocking-in the composition

in black and white, and experimenting with the
areas of light and dark (Fig 01). The reason |
chose this particular angle was because | felt
that the foreshortened size of the ship seemed
exaggerated, and as a result gave it a more
imposing quality, as well as adding a certain
dynamic. | predominantly used two brushes to
establish the tonal range, which can be seen in

Fig 02.
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Fig05

They are both hard-edged yet retain a painterly
quality. The top example (see Fig 02) is one of
my custom brushes, and the lower one is one

of Photoshop’s default hard, round airbrushes.
They both utilise opacity set to “pen pressure” to

enable more control and a level of transparency.

Building up. the Delails
With a medium grey | then began to tie the sky
and the sea together, and tidied up some of
the lines of the bow and refined some of the
structures above the deck (Fig 03). Having
made a reasonable start on the tonal ranges

it was then time to add some colour, which
was done on a separate layer set to Overlay
blending mode. In this way the light and dark
areas remained, even though colour was being
added (Fig 04). | began by using a subtle
blue/green and also painted in some random
horizontal strokes to help define the water a
little. As this painting was meant to depict a
torpedo collision it was about time we added
some action into the scene! For this | created
a custom brush, as seen in Fig 05, which is
illustrated in the bottom-right of the image.
When some scattering was applied it created
an effect similar to the top-most brush stroke,

which has the effect of appearing more broken

Fig03

and will be suitable for something else later...
Anyway, | decided to have the torpedo hit
towards the back of the ship, and with my new

brush | painted in a splash with a bright white,

Fig04

Fig06

making sure that the centre was more opaque
and fading towards the edges (Fig 06). | added
this on a separate layer so that it could be

moved and altered with ease if need be, as
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it was done very quickly. To add some extra
drama | wanted to add a torpedo wake passing
just in front of the ship, just narrowly missing
the hull. This was also done on a separate
layer using the same brush, but this time with
scattering applied so as to describe the tiny air
bubbles made by the propeller. The reason this
was on a new layer was because it needed to
be set to Overlay mode in order for it to appear
darker in the shadow of the ship (Fig 07). The
way to achieve a sense of perspective is to
either paint in a shape and then use the Edit >
Transform tools to Skew and Distort it so that it
tapers off, or alternatively one can simply use
the Eraser tool to do it manually. You may also
notice that | have painted in some evidence of a

land mass on the far left of the horizon

”Eﬁ}lm ﬁ& 7W At this point | thought that the torpedo splash was becoming somewhat lost amongst the very bright area of sky behind
it, and as a result was subduing the impact - pardon the pun! Using the Gradient tool | overlaid a grey/green (inset square) from the top of the image
towards the horizon, and similarly from the bottom up to reflect the sky. Being set to Multiply mode this also served to create a more ominous mood to the
picture and also emphasised the splash (Fig 08). | worked back into it with a soft edged eraser in places to bring out some cloud formations, as well as
adding some further refinements to the ship, together with a line of flags. | generally cleaned up the edges and put in some simple shadows and highlights
to help describe the scale, as well as shifting everything back a little towards the rear of the boat, because the perspective seemed wrong as it was. The

next step was to put the guns in, which were done in single strokes using a hard-edged brush. A little shadow was painted in below the larger ones to add
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some volume, as well as a few elements at the

bow (Fig 09). You will also notice that | have
continually added areas on the ship and then
maybe erased them later down the line. Do not

be afraid to change things and experiment as

you work - it is good practice to keep things fluid
and to try alternatives as you work as this often
yields positive results that you could not have
predicted. In Fig 10 | have added a wave along

the bottom of the ship to show that it's moving, as

well as adding some more density to the torpedo
splash. In Fig 11 | have put in some detail along
the hull of the ship to break up the consistency of
the hull and to give some indication of scale by

way of some metal panel. shapes.
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Fig12

MUI# m The picture is now essentially complete and could be left, but a few quick enhancements can improve things. Because | left
the torpedo wake on a separate layer | can now duplicate it easily, and after a bit or re-adjustment create a gap down the line of air bubbles which is
more realistic. Also, using a simple brush, | added some random strokes around the splash to widen the spray, as well as some swift random marks to

add more definition to the water. | put in some evidence of railings and a few highlights and finally used a large soft airbrush to lighten the horizon and
water and to paint in some simple suggestion of clouds.



Rich Tebbuny

Mwﬂ The finished picture can be seen in Fig 12. | am happy with the final result but as with any speed paintings the temptation is to
get carried away with unnecessary details. | spent just over two hours on making this image and feel it was a useful exercise. | may well attempt to paint

another image on the same theme, except next time limit myself to one hour, just to see how the result compares. The crucial lesson to bear in mind

with this type of painting is to acquaint yourself with the subject matter beforehand and have as clear an idea as possible about composition and colour

schemes before you begin, as it will inevitably save you much time during the painting process.



This tutorial has been written

for the young generation of
artists/graphic artists who wish

to build up their knowledge of
professional and classical colouring

in a cartoon style, for work intended to

be published and printed...

Colouring

LINE DPa\NlncS
Ready for Prin



Lobruning

a Line Dhawing Ready fon Print

Colouring a
Line Drawing
Ready for Prin

Orealed In-

Adobe Photoshop CS2; scanner; blue colouring
pencil; black pen (for inking-in lines); graphics

tablet.

Fig02a

7ah0&wltm I won't be explaining in this tutorial where to shade, or how to choose colours,

but instead | will talk about how to make the most of the flexibility of Photoshop CS. | have used this
technique several times in my own work as a freelance lllustrator. CMYK is a colour mode which
represents the first letters of the colours used by printers, which stand for Cyan, Magenta, Yellow and
Black (K). As the diagram shows you, in the bottom-right corner of Fig01, those three colours - cyan,
magenta and yellow - should be enough to obtain black simply by mixing them together. However, the
quality of paper and inks available often mean that this combination is imperfect and you actually end
up with more of a dark maroon/green. This is why black ink is essential as both a support and also to
add depth to the other colours. | intend to show you how black ink can be used for lines, and how cyan,
magenta and yellow inks may be used for the colours. With this method your lines will be more precise

and intense; your colours will not contain black, and will be more luminous.

Fig02b Fig02c
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Lobruning

a Line Dhawing Ready fon Print

Fig01

Inom Theony lo Praclice

For the drawing | use a blue Faber Castel pencil, because you can often
buy these individually. However, for your first attempt any old, blue pencil
will do the job. The blue pencil allows you to draw a sketch onto paper
without it looking as if it has already been scanned. This is a godsend
when you realise that a grey pencil seems to “dirty” the paper and often
needs erasing - this destroys the clarity of your black lines. Inking is then
carried out using a felt pen of around 0.3 mm; | use either a Staedtler
pigment liner or a ball-point pen. | also use Bristol paper which assures

fluid lines (Fig02).

| scan the drawing in Adobe Photoshop CS2 at 600 dpi - in grey - using

a high quality, Canon scanner, which achieves a high resolution (go to

File > Import > Select Scanner). In the majority of cases, the result is too
light, and there will also be also grey in the black lines, but this depends
upon the quality of the scanner that you're using (Fig03). To correct the
clarity of your line drawing go to Image > Adjustments > Levels. By placing
the pointers in a similar way to the graph shown above, you will improve
the black and white zones of your drawing. Try out various adjustments
and you will quickly find the best one for you. Beginners may prefer the
Brightness/Contrast control simpler, but this might not be flexible enough

for more experienced illustrators (Fig04).
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You now have to configure the colours in your
drawing (go to Image > Mode > CMYK). | create
three layers in Photoshop and re-name them

by double-clicking on each layer, upon which a
box should appear. The first layer will be called
“Black lines” and is where you will only be able
to filter the black layer : (Fig 05)

a Line Dhawing Ready fon Print

Fig05

It is here where Photoshop CS2 is essential,
because its predecessor did not perform this
command quite as easily. The second group
of layers are for Cyan, Magenta and Yellow
colours (“CMY colors”), as shown in Fig06 and

here:

Fig06

third group is for the background. By double-
clicking on the Background layer | change it
into a copy, re-name it, and then click “OK”.
Now they are changed into copies the lines

of the drawings should be movable. Click and
hold the copy whilst dragging it into the group
“Black layers” and it will join the group. Keeping
the “black lines” copies open, | change the
blending mode parameters (see “c —” in Fig07)
to a suitable mode. This will make the whites
transparent, and therefore the drawing will

become more like a drawing on a transparent

e e® Fig08
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sheet. | create a copy using the icon labelled “b
1” (Fig07) in the Copy box, transfer it into the
Background box, and then fill it in white using
the Paint Bucket tool. Finally | create a copy

in the Cyan/Magenta/Yellow group, which will
act as a base for receiving all of the colours.
The configuration of the file is now finished

and colour application can now begin. | start
by filling in the basic colours, initially using a
basic brush and filling each zone thoroughly
(Fig08). | change the colours progressively

on this copy using the Magic Wand tool and

by using the Colour/Saturation box (press the
Ctrl + U hot keys) in order to vary the colours.
To create shading, | make another copy in the
Cyan/Magenta/Yellow box and fill it with a light
purple colour, and change the blending mode.
Then in Menu > Layer > Add Layer Mask > Hide
Selection, the Layer Mask will act as a “scratch

card”. Using a white brush, | draw in the shading

Lobruning

a Line Dhawing Ready fon Print

Fig11

Fig09

by leaving the purple layer in specific areas and
using a black brush to get rid of them in certain
places (they are left in at about 50% with grey).
The interesting part of this technique is being
able to vary the colour of the shading without
impairing the drawing, and also being able to
change the shading easily (Fig09). | also use

a 60% white opacity copy on this, as a mask

to cut little reflections into (white spots seen in
Fig10). My final layers are for the special effects,
like the stars or little white reflections, which

are created using a special brush (see Fig11). |
also drew a background in the group in order to
add emphasis to my scene. After several hours
of work my picture is ready to be printed, so |
export it to a PDF or TIFF file, according to the
printer being used. To make your file lighter, you

could also try flattening the layers.

Well, it's over to you now! Don't hesitate to post
your work in the Work In Progress sections of

forums to get some valuable advice!

Fig10
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The Slightly Philosophical Approach to Sub-Surface Scattering JaL‘J’M[aca J’callau'ny

Philosophical

Approach to Sub-Surfacechttering

Orealed In-

Photoshop

Inbroduction

If you want to make a transparent object that
you are painting appear to be realistic, then it's
certainly not enough just to know where the
layer's Opacity slider is. Light has a distinct
behaviour within translucent objects, and just
like in anatomy where the artist's understanding
of underlying forms makes his paintings more
convincing, the understanding of this behaviour
will help us to identify the effects that we see.
More than that, it will also help us to work out
how an imagined, nonexistent object would
look if it were to exist. But what is “existence”
exactly? We paint what we see, and what

we see is nothing more than reflected light.
The image we perceive through our eyes is
transferred to the brain through the optical
nerves, where it gets processed and the object
is recognised. Things we imagine, however, are
also produced in the brain and trigger exactly
the same “strings” as the pictures we receive
through our eyes. So, since we have no way

to tell the difference between things that are
real, and things that we imagine, how do we
know what is “real”? Well, we don’t. Throughout
the ages, a great number of scientists and
philosophers have wondered if whether the
world we see actually exists, or if it is all just

in our minds. For the purpose of this tutorial
however, we will just have to assume that the
world we live in actually exists and is guided

by some certain physical laws and principles;

a small part of which | will try to explain in the

following study...
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Fig02

Fig03

Fig04

Whal is Fub-Furface Scalloning?

So, what does triple-S stand for? Nope, it's not one huge S; those three
letters actually mean “Sub Surface Scattering”. And don't get fooled by
the name either; if you envision the mechanics of subsurface scattering
somewhat like the one in Fig0, then I'm sorry to tell you but you're wrong
once again. To put it simply, SSS is a property of light, and it occurs in
basically every object which allows light to pass through its surface (but
that doesn’t count for objects that you have to drill a hole in first). Whilst
solid, opaque objects (Fig01) reflect light without the light penetrating

their surfaces, with translucent ones the light actually enters into the

object. Once there, light doesn't just continue travelling in a straight line,
like we might imagine it would. The light rays - just like very small and
somewhat fast pin-balls - bounce off the tiny particles which build the
object’s structure, and scatter; changing in direction and colour (Fig02).
When you cast a strong light onto the back of your finger, you should see
a visible glow around the edges (Fig03). When light enters the object, it
hits a particle and splits. The split rays also split, and this splitting of light
rays continues. Reflected from particle to particle, light can actually travel
inside the material’'s mass, no matter what curves it may have (Fig04).
Because of this, light often comes out of an object in a place where we

may not normally expect it to if it were travelling straight, for example.
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Fig05

Fig07

This causes another effect: since light can exit into unlit, darker areas,
then objects with SSS seem to have an “inner glow”. Dependent upon
the colour of the material, the exiting colour of the light also changes. For
example, human skin is full of blood vessels, and so the light travelling
through it is coloured red. So if you're really, really curious about whether
Kings have blue blood, you don’t have to kill one to find out — you just
have to make one sit still and light him properly. Another myth busted!

All materials have a maximum depth at which the light can penetrate to.
For example, in an ideal scenario of having a single, consistent material,
let's take a glass of milk - which has its “translucency depth” (see Fig05).
In the case where a fly makes an emergency landing into that cup of

milk, you would be able to see it clearly when it was on the surface of

The Slightly Philosophical Approach to Sub-Surface Scattering JaL‘J’M[aca J’callau'ny

Fig06

Fig08

the milk. The further into the milk’s mass that it sinks, the blurrier it gets
and the more it fades into the milk’s ‘colour’, until it finally disappears
(remember not to drink that milk now) (Fig06). (Please note that no flies
were harmed in the creation of this tutorial - they were drawn rather then
drowned.) A good analogy of an SSS effect is like having a fog (with

the material’s main colour) and a depth of field effect (focal point at the
surface) combined. For our own purposes we can treat the blur and the
coloured fog as the same distance, however their “translucency depth”
may differ in real life. The translucency depth depends upon the density
of the material (which in the upper example depends on the species of
the “milked” animal and the date that it took place) (Fig07). Light intensity

reduces exponentially from A to B. In dense materials translucency depth
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Fig09

is shorter, and is longer in more translucent materials. This SSS value is
also interconnected with light intensity. The brighter the light, the more the
translucency depth will stretch, and light will be able to pass deeper into
the object. With SSS materials we also have the effect of shadow depth.
If we have a shadow cast over the translucent object, then we will note
that its edges aren’t crisp, but it blurs into the underlying object (Fig08).
The darkness of the shadow seems to penetrate the surface - scattering
underneath it. Since shadow is actually the absence of light; light enters
the surface around the shadowed area and spreads wider, causing the
shadow to narrow in depth. This effect is also visible when another object
is inside a translucent one, where the non-translucent object will cast
narrowing volume shadows (Fig09). This effect will be close to what we
see when bright light enters a dusty room from a window, where any
objects blocking the light's path will cast visible volume shadows. The
single difference would be that the environment in which these shadows
are being cast is much denser, and due to the SSS of light we get the

narrowing and diffused look of the shadow.

How lo Paind Sub-durface Scallening?
Knowing these principles you can paint SSS using any technique you
want. The purpose of this tutorial is to explain what to do, rather than
how to do it, so | will not enter into too much detail in this part, and I'll
presume that you are familiar with the software that you use. Here is how
| paint when I'm aiming to get realistic results - it's pretty much software
independent, though | personally use Adobe Photoshop (all of the before

mentioned illustrations for this study were created using this technique):

Fig11

dlep 1

First, paint the object like you would a normal, non-translucent object.
Normally, | start with a quick sketch (Fig10), then clear the outlines and
proceed to filling it with colour. Usually, | pick a neutral grey to paint. |
then shade it using the Burn and Dodge tools in Adobe Photoshop (which
basically darken and lighten the image). For the first shading part | paint
a soft shadowing ambient, which is the kind of lighting you will nearly
always have present in the unlit, darker areas, no matter what lighting you
choose. | use soft brushes in differing sizes. When the ambient-lit image
is done, | then add colours using coloured layers with different Overlay

modes (Fig11).

Ilep 2
Now it's time to kick some triple-S! As explained previously, where the

translucency depth is longer than the volume thickness, light will pass
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through your object. The thinner the volume, the more light will pass
through it, and the more the colours of the background will show through
it. Imagine that your translucency depth is a stick which is coloured

with a gradient - white at the base (where light enters the surface) and
transparent at the end (where the material will no longer allow light to
pass). | try to keep in mind the volumes of the object whilst mentally
sticking the stick from the back to the front of the object, so that it's
perpendicular to the camera and facing the eye of the viewer (Fig12). |
paint in the colour of the translucency depth stick in the point where it hits
the surface facing the eye. Don't feel too bad about back-stabbing the
object that way - you are painting the SSS equivalent of ambient lighting,
which is something that you will have in nearly every lighting condition.
There is no need to be precise here, simply paint approximately what you
think the passing light intensity is at the exit point. In most cases you can
enrich the image by adding another layer: background bleed. Use the
layer seen in Fig13 by applying “Levels”. Make the gradient much thinner

and closer to the surface, and use it to select and copy over the object the

The Slightly Philosophical Approach to Sub-Surface Scattering JaL‘J’M[aca J’callau'ny

background layer colours. Again, you can go through this process any way
you want to. | use a white-to-transparent gradient because | often use the
layer's transparency afterwards for selections, and because | can see the
layer underneath (the object itself) as opposed to when using a white-to-
black gradient. (The illustrations here are presented in a white-to-black

format for viewing convenience only.)

dlep 3

After we finish the overall base for the image it’s time to get into the real
lighting. The next step is basically like the previous one, only you must
stick your translucency depth stick somewhere else: pace it along your
key light vector. In this picture we place our key light on the left so that
we are pointing the stick from left to right along the path of the light beam

(Fig14). Once we get this layer done we’re ready to finalise the painting...

dlep

Normally | would use Overlay mode for the two layers, and would play
around with the Opacity value (Fig15). If needed, you can then duplicate
one of them to strengthen the effect. If you have a really translucent
material you can select the layer transparency of the first SSS layer, copy

the background colours on top of the object (depending on the level of
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refraction you can offset or even flip the image
vertically), and then blur them according to the
material’'s density. Don’t be afraid to experiment
with the layers - you might find your own, or
even a more convincing way to paint SSS. Be
brave; Undo is a mighty weapon to have at your
disposal and is a luxury that classical artists
don’t possess. Your image should be now more

or less ready...

dlep 5

At this stage | would normally flatten my layers
(Fig16) and play around with the Dodge and
Burn tools again. I'd also add a specular layer,
and an ambient colour (environment lighting)
layer (both shown combined in Figl7). Try
changing your Dodge settings to “Highlights”,
and refine the SSS areas a bit more. Do it with a
larger brush and a single stroke so that you can
use the “Fade” option from the Edit menu. This
allows you to adjust with what opacity you apply
your last stroke, which is very useful when fine

tuning your image. Fig16

dlep 5

You should now be ready to print it and show it
to your girlfriend. Watch out for the translucent,
rotting zombies, but if you've painted a cute,
gummy heart then you should be in for a good
time. Remember that your painting doesn’t need
to be 100% accurate; stay close to what you
think is true, and you will probably get results
which will look good enough, and as long as
they are convincing they don’t need to be
physically correct. In fact, | don’t pretend that
what I'm suggesting is scientifically correct; it
just helps me produce believable results. I'm
not a scientist and most probably you are not
one either. After all, we're doing artwork, not a
scientific study. Besides, if this world doesn’t
actually exist, you'll be wasting time... which
you don't actually have because there’s no such
thing as time, right? Then why waste something
you don’t have? It would make no sense, would
it? Anyway, in case it does exist, thank you for
reading, and | hope this study has been of some

help to you.
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Digilal Painling

dailures and Juccesses

The evolution of the world involves the success
and failures made by people, and nature’s other
inhabitants and resources. The same proves
true when applying this context to art. The
evolution of my art (and most likely anyone’s,

| believe) is partially based upon the mistakes

that | have made and have learned from, which
are all going forward to evolve into successful
triumphs. Although what may be a success to
me, may be at the complete opposite end of the
spectrum through your own eyes when looking
at the final results. Keeping this in mind, let's
move forward through the piece that I'm going to

walk you through today...

dlep 1: Fiqo)

To the below left, you will see a quick sketch
which suggests the central ideas that are
coming into focus. To the below right, you will
see a rugged exploration of some colours and
shapes. At the very bottom of this page are the
main tools and palettes that were used whilst

painting in Corel Painter IX. Two main brushes

Making of eguvenalon of the Human flame

were used: Eraser Brush (standard) and Detall
Airbrush. When laying down colours and details,

| blend by decreasing the brush’s Resaturation
option to 0%, and “viola™! To affect the level of
control for blending whilst the Resaturation is set
to 0%, | simply play with the percentage of the
brush’s Bleed. The circular Colours palette is the
one | visit most often as | lay down my colours,
although lately I've also been expanding the
Colour Sets palette for easily picking pre-selected

colour values.

3’@3: (Fig02a - ¢)

| then start work fleshing out the faces, body
structures, and wardrobes - all the while trying
to maintain a sense of balance. After major

changes, | generally tend to temporarily flip
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Rejuvenalon of the Human #ame voiing of

the image in the opposite, horizontal direction

to easily spot any incorrect proportions or any
other undesired oddities. This process also
aids me in cropping the canvas with more

satisfactory results.

JZ'.'p».?: (Fig03a - b)

After having worked with the four, main
characters for some time now, they appear

to be more of a clustered mess at this point. |
make a decision to add more interest and break
away from the dreadful monotony by increasing
the size of the canvas more vertically, and by

adding larger-than-life faces.
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3@1 42 (Figo4) 3’@5: (Fig05a - c)

Lighting has been unplanned so far, and rather surprisingly neglected, The second character is now added - opposite the female doppelganger

S0 it’s time to rectify this problem. Using a round gradient in Adobe with the blackish rose - because the picture was crying out from the

Photoshop, | make a decision to change the tonal feel of the piece. negligent lack of compositional balance.

Issue 017 May 2007


http://www.3dcreativemag.com
http://www.2dartistmag.com

Rejuvenalon of the Human #ame voiing of

M5: (Fig06a - d) M]: (Fig07a - c)
A third character that bumps its head out from the top should help to As the final stages come into play, my decision-making seems to become

further influence a more pleasing sense of weight to this unexpected more cautious and “mother-like”. In the left image (above), | clean up

cluster of characters. the background and prepare for the extraction of the characters (since
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everything has been worked on one, flat layer
up to this point) using the Polygonal Lasso tool
in Photoshop. In the middle image (above),
the characters have been removed from the
background and placed on their own dedicated
layer for easy, future editing. Highlights are
also added to the silhouette of the characters
to enhance lighting conditions. To the right
(above), you can see the final results to this
piece. All kinds of post-effects have been
painted in, like the snow and the ghostly,
illuminated tree branches, along with many other
little touches which all work to tie everything

together .

Flonies wilth Endings

This piece, as many others that | have
previously worked on, has its share of
successes and failures. Saturation of colour

and lighting were true failures that were
thankfully taken under closer observation,

and corrected towards the end. The contrast
gives me a neutral feeling because | think the
art came out with an OK ‘punch’, but it could
have been pushed further. The perspective

was predictable and underwhelming for me. As
the title suggests, “Rejuvenator of the Human
Flame”, upon the completion of this piece | have
regained my passionate flame to do more art, as
| was having a rather malfunctioning art block so
to speak... | have therefore learned by studying
others, and by brainstorming a great amount
too. | have hopefully become a little wiser in

preparation for whatever | may work on next.

Most of my concept art works develop their
stories towards the final stages of their creation.
Now, here is a little treat to give you the story
behind what this painting is all about, now that

everything is all said and done:

There'’s a greenhouse engulfed by a forest
around Adeline Vaillant's mansion grounds,
where all of her passion and dedication takes
place. She possesses a special talent of utilising
the proteins that run through the veiny streams
of plant life to reanimate the deceased back
into the living world. These perfectly rendered
humans with such unique qualities, make the
trees turn stark white, and the plants sway
wildly, as these doppelganger beings walk past
them. The skin of these rejuvenated spirits
bounce back with a pale, twilight quality, with no
presence of blood flowing through their veins;
just soft, plush, doll-like cheeks which easily

give away their inhuman camouflage...
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For more from this artist visit:
ivanushka.deviantart.com

Or contact:

ivanMijatov@gmail.com
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Hecale is said lo haunl a three-way
cenossnoad: each of hen heads /acuw ina
different dinection. She is said te appean
wien lthe ebony moon shines. Bul ] would
like Lo creale something a bil different to

lhe neal mylh...
Xiao Bing takes us
through the Making Of
one of his creations,
“Hecate”. Xiao has
taken the Greek
Goddess, Hecate,
and produced his own

version...



Hecate

Iniroduction

Hecate is the Greek Goddess of the crossroads
Wilderness and Childbirth. She is usually seen
with two ghost hounds that were said to serve
her. Today she is often seen as a goddess of
witchcraft and evil. Hecate is said to haunt a
three-way crossroad; each of her heads facing
in a different direction. She is said to appear
when the ebony moon shines (see Fig01 for
reference). But | would like to create something

a bit different to the real myth, because in my

Fig02

Fig01

mind there must be a round moon behind her.

In history, she is said to haunt a three-way
crossroads, but to create something different I'm
going to put three keys in her hand. Hecate is a
Greek Goddess, with Greek traditional clothes,
so | will give her a long skirt. | don’t know why
all the girls in my paintings are so heartbroken;

maybe there is a crack in my own heart...

Fhelching
| start out with a blank, white document.
Following my original concept | want to set

my image at night. She will have a light in her
left hand with three keys attached, and will be
walking around the three-way crossroad under
the moon. | was satisfied with the original sketch

(Fig02).
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MW_"F’ Fig03

| draw the first colour on a new layer. Picking colours for your palette is

a very good idea, even in the first stages of a painting. | put both a deep,

blue colour and a skin colour onto this layer (Fig03).

Beauliffuldace

| keep drawing using my technique, with my goal to paint her face. | chose
a precious stone’s blue colour to light her eyes; a tear streaming from her
eye; her lips shut tightly. | finish drawing the figure of the body and the
skirt with my colours. Right now | want to attempt to change the colours to
give my painting a different feeling, and to make it “prettier”. To achieve
this | used Photoshop’s Colour Balance to change the Cyan, Magenta and
Yellow (Fig04). Each group of colours display a different mood; it's very
difficult to give them up. | chose to use the mood created by the colours
seen on the right of Fig05. With embellished hair and lips, and with the
harshness of the face having been adjusted, the face is now basically

complete (Fig06).

Fig04

Fig05
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Fig06
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Fig07

Fig0s

Fig10

Background

Then | paint the mist in background. My technique of painting uses

Photoshop’s brush called “Airbrush Soft Round 17" (Fig07), with which

| paint blue, using different shades and tones of the colour to achieve

light and purity. | then use the Smudge Tool and a brush called “Chalk

60 pixels” to continue painting the background (Fig08). | have now spent

about 15 hours on my picture, because 70% of it has been finished

(Fig09).

Deconalive Pallenn

In my remaining time | add some decorative pattern for the blue skirt. First

| draw a pattern on a new layer named “flower1”, which | set to Screen

Fig09
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Fig11a

Fig11b

mode. | then set the copy layer named "flower1
copy” to Multiply mode. Don't forget to erase the

edges to achieve the right effect (Fig10).

To make this picture more lively, | will draw a
bird under her right hand. Birds’ feathers should

be drawn carefully, and so | must pay attention

to the direction of the light (Figlla - c).

Figl1c
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Hloon and
Light

It took me 4 hours

to paint the moon

and the light held in
her hand, which has

a glowing emerald
inside. | also add
some fireflies flying
around the light (Fig12
-13).
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http://cabotinecco.cgsociety.org/gallery/

Or contact:

C_cco@hotmail.com
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Tuoriel nothen Rainy Uay

Another

Raiiiy

Loncept

In this tutorial | will be showing you how to paint

Day

a rainy day scene without having to paint any
weather effects, but rather the feeling will be
conveyed purely based around colour, mood,
and some reflections on the street. | took the
photograph on the right myself, a long time
ago. Itis a good idea to always shoot your

own reference material, because that way you

don’t have to worry about any copyright issues,

especially if you want to sell your painting. When you are taking your
reference, be sure not to use the flash. Using the flash will destroy any
kind of lighting scheme you wanted and will also wash out the subject.

Now that | have my reference | can get started...

75& BM?IL (Fig01)

For the most part of this tutorial | will just be using two different brushes for
this painting; a round brush and a rectangular brush (I have included my
brushes for download at the end of the tutorial). When | am painting from
reference material | open the reference and place it next to my canvas.
This way | can always look over at the reference while | am painting. |
start out by painting in the colour of the sky, and then block in the main

silhouettes of the buildings in a dark colour, but not pure black. Right now

Fig01
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| am using the natural, rectangular
brush. I like using this brush
because it is very versatile in the
fact that you can get soft shapes
as well as hard edges. You can
also rotate the brush to get brush
strokes in different directions.

After | have all the main shapes

in place | need to put in the base
colour of the buildings (Fig02 - 03).
Using the same brush | paint the
buildings in the background with
less pressure, as opposed to the
buildings in the foreground. Usually
things further away are softer,

and things closer are sharper.
Even when | know a building isn’t
going to be dark in colour, | will still
block in the silhouette as a dark
colour because that way | can get
some of the dark colour to show
through (Fig04). This will give the
surface some more texture and
depth, otherwise it will look too
flat. | continue to work all around
the canvas and try not to focus on
any one particular element (Fig05).
This will allow me to get a greater
feel for the image as a whole and
not to worry about spending too
much time on something, only to
have it be out of place or in the

wrong perspective.
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Mw MB DM used to simulate rain droplets on the rear window of the car is a type of

speckled brush (Fig08) (I also use this brush a lot when | am paintin
One of the really cool elements in painting a cityscape is the lights (Fig06 P (Figos) ( P 9

facial hair on men). The red tail lights look OK right now, but | reall
- 07). The red tail lights of the cars act as a directional element that lead ) g g Y

wanted them to feel like they were glowing. An easy way to do this is the
the viewer’s eye throughout the piece. Adding lights will also give your y g 9 v way

. . - . . o use the “colour dodge” setting on the brush (Fig09). Do not use the actual
illustration a livelier feel to it, almost as if it were alive itself. The brush |

Dodge tool because this will desaturate and wash out your painting, but

Fig08
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Fig09

instead use the Brush tool, and from the drop down menu select “colour
dodge”. Using this setting will preserve colour in your painting and will
make it glow. | usually pick a darker colour than what | want, because
otherwise you will risk over-exposing your image. In order for this to work
you will need to use this brush on a layer that has your entire illustration
on one layer. If you are working in layers just hit the Ctrl + A hot keys to
select the entire canvas, and then again hit Ctrl + Shift + C to copy all
layers. Now just hit Ctrl + V to paste the illustration into a new layer. Now
you can use the colour dodge brush on this layer. The other brush that |
used a lot in this illustration was just a Photoshop, default, round brush,
with the Opacity set to Pressure (Fig10 - 12). Using this brush will give me
some harder edges than the rectangular brush | used for blocking in the
main shapes. Edge control is a very important aspect of a painting, and
can cause an illustration to either succeed or fail. Most of the time | use
the hard, round brush for when | am painting elements such as railings,

poles, and wires. | try not to use the Shift key

for drawing straight lines, but instead | just do
them freehand. Doing this will give more life to
your painting and it won't look so mechanical.
Some of the lines look pretty straight, but that is
only because | will keep redrawing the same line
over and over until | am satisfied with the way

it looks. Remember that the Ctrl + Z (Undo) hot
keys are your friends. For many of the colours |
have been picking colour directly from the photo,
simply because it saves a lot of time. | would

actually advise against doing this because it

Fig13
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doesn’t require any thought. In time you will start to lose the understanding
of colour and you will not be able to identify which colour is which. You
will begin to catch yourself thinking, “is that colour more blue or yellow?”.
It is good practice to look at a colour in a photo and try to pick the colour
yourself just by looking at it. Also picking colours from a photo is generally
bad practice simply because colours in photos are usually not very
accurate, and can be washed out or dull. But anyway, | am being bad and
colour-picking here! | wanted some more colour harmony in my piece, so

| decided to change the Colour Balance of the illustration (Fig13). An easy
way to do this without actually changing your painting is by clicking on

the half-black, half-white circle at the bottom of your layers palette. Doing
this will open up a window in which you can choose different options to
change. | chose “Colour Balance.” The colour balance dialogue box will
open, and it is here that you can change your colours. | pulled the sliders

towards more Yellow, Magenta, and Cyan. You

can also change the tonal balance by selecting
Shadows, Midtones, and Highlights. It is fun to

play around with these different settings.

The Jinal Touches

All that is left now is to add in some of the

final details to the buildings, like the windows,
signs, and railings (Figl4 -17). | am also adding
in the rest of the cars on the left-hand side.
These steps only take a few minutes because

| am painting pretty loosely. One of the things |
always battle with is how refined | should make
the illustration. For this painting | wanted a more
painterly feel, and not something that looked
too photo realistic. You can see by the detailed
shot that the cars are pretty loose, especially

the ones that are further away from the viewer

(Fig18). Even when | am painting something
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this small | still paint zoomed out to about 25%. This allows me to keep things looser, and | can also
judge what it will look like zoomed out at the same time. | think the hardest thing that | battled with
in this illustration was the sign on the right (Fig19 - 21). Adding lettering to any illustration is tricky,
because people like to read things in paintings, and often they take a lot of focus away from the rest
of the piece. | didn’t want the sign to be too much of a focal point, and | have been avoiding finishing
the rest of the text. In the end | finished the text, but | tried to keep the value range between the

letters and the background fairly similar so as to not call too much attention to it.

Fig21
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PUBLISHING

Is a Company publishing downloadable online
magazines. It is based in the West Midlands
in the UK. Zoo currently produces two online

downloadable magazines, 3dcreative and
2dartist. Zoo's intention is to make each issue
as full of great articles, images, interviews,
images and tutorials as possible. If you would
like more information on Zoo Publishing or It's
magazines, or you have a question for our staff,

please use the links below.

Lontacl Infornmalion
www.zoopublishing.com
www.3dcreativemag.com
www.2dartistmag.com
Editor > Ben Barnes
ben@zoopublishing.com
Assistant Editor > Warin Pismoke
warin@zoopublishing.com
Marketing > Lynette Clee

lynette @zoopublishing.com

Paninens

If you have a CG Community website, and
would be interested in reselling 3DCreative or
2DArtist magazine please contact Lynette Clee

on the eMail address above.

www.2dartistmag.com
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